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Value-Added Reseller (VAR) Language 

Oracle Retail VAR Applications 
The following restrictions and provisions only apply to the programs referred to in this section and 
licensed to you. You acknowledge that the programs may contain third party software (VAR 
applications) licensed to Oracle. Depending upon your product and its version number, the VAR 
applications may include: 

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation 
(MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail 
Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications. 

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of 
Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory 
Management. 

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, 
and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags. 

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of 
San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization 
application. 

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR 
Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding 
any other term or condition of the agreement and this ordering document, you shall not cause or 
permit alteration of any VAR Applications. For purposes of this section, "alteration" refers to all 
alterations, translations, upgrades, enhancements, customizations or modifications of all or any 
portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-
engineering or reverse engineering and recompilations or reverse compilations of the VAR 
Applications or any derivatives of the VAR Applications. You acknowledge that it shall be a breach 
of the agreement to utilize the relationship, and/or confidential information of the VAR 
Applications for purposes of competitive discovery. 

The VAR Applications contain trade secrets of Oracle and Oracle's licensors and Customer shall 
not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or 
other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to 
replace, with functional equivalent software, any of the VAR Applications in future releases of the 
applicable program. 
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Send Us Your Comments 
Oracle Retail Macro Space Management, Product Studio User Guide, Release 14.1 

 

Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 

 Did you understand the context of the procedures? 

 Did you find any errors in the information? 

 Does the structure of the information help you with your tasks? 

 Do you need different information or graphics? If so, where, and in what format? 

 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 

Please give your name, address, electronic mail address, and telephone number 
(optional). 

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 

http://www.oracle.com/
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Preface 
This guide describes the Macro Space Management user interface. It provides step-by-
step instructions to complete most tasks that can be performed through the user 
interface. 

Audience 
This User Guide is for users and administrators of Oracle Retail Macro Space 
Management. This includes merchandisers, buyers, business analysts, and administrative 
personnel. 

Documentation Accessibility 
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.  

Access to Oracle Support 
Oracle customers that have purchased support have access to electronic support through 
My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired. 

Related Documents 
For more information, see the following documents: 
 Oracle Retail Macro Space Management Release Notes 

 Oracle Retail Macro Space Management Administration Module User Guide 

 Oracle Retail Macro Space Management Configuration Module User Guide 

 Oracle Retail Macro Space Management Data Importer User Guide 

 Oracle Retail Macro Space Management Fixture Studio User Guide 

 Oracle Retail Macro Space Management Product Studio User Guide 

 Oracle Retail Macro Space Management Report Designer User Guide 
 Oracle Retail Macro Space Management Merchandiser User Guide 

 Oracle Retail Macro Space Management Planner User Guide 

 Oracle Retail In-Store Space Collaboration Release Notes 

 Oracle Retail In-Store Space Collaboration User Guide 

 Oracle Retail In-Store Space Collaboration Mobile User Guide 

 Oracle Retail Macro Space Planning Installation Guide 

 Oracle Retail Macro Space Planning Data Model  

 Oracle Retail Macro Space Planning Security Guide 

  

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 

https://support.oracle.com 

When contacting Customer Support, please provide the following: 

 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 

 Exact error message received 

 Screen shots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for 
example, 14.1) or a later patch release (for example, 14.1.1). If you are installing the base 
release or additional patch releases, read the documentation for all releases that have 
occurred since the base release before you begin installation. Documentation for patch 
releases can contain critical information related to the base release, as well as information 
about code changes since the base release. 

Improved Process for Oracle Retail Documentation Corrections 
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in the 
case of Data Models, to the applicable My Oracle Support Documentation container 
where they reside. 

This process will prevent delays in making critical corrections available to customers. For 
the customer, it means that before you begin installation, you must verify that you have 
the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

An updated version of the applicable Oracle Retail document is indicated by Oracle part 
number, as well  as print date (month and year). An updated version uses the same part 
number, with a higher-numbered suffix. For example, part number E123456-02 is an 
updated version of a document with part number E123456-01. 

If a more recent version of a document is available, that version supersedes all previous 
versions. 

Oracle Retail Documentation on the Oracle Technology Network 
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
product documentation is also available on the following Web site: 
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html 

(Data Model documents are not available through Oracle Technology Network. These 
documents are packaged with released code, or you can obtain them through My Oracle 
Support.) 

Documentation should be available on this Web site within a month after a product 
release. 

https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
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Conventions 
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.”  
This is a code sample 
 It is used to display examples of code 
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1 
Overview of Macro Space Planning 

Overview of Macro Space Planning 
The Macro Space Planning Application (which includes the Planner and Merchandiser 
modules) is described in the diagram below. 

 

Macro Space Planning 
Macro Space Planning consists of two applications sharing a common database: Macro 
Space Management and In-Store Space Collaboration. Macro Space Management is 
intended for use at headquarters and has functionality not replicated in In-Store Space 
Collaboration. In-Store Space Collaboration is designed to be portable and can be used 
(via the Internet) at stores within a retail organization. ISSC also has an extension - ISSC 
Mobile. 

Macro Space Management 
Macro Space Management consists of two sorts of modules: store planning modules and 
support modules. 

1. Store Planning Modules 

Store Planning can be carried out in Planner (AutoCAD environment) or 
Merchandiser (Virtual Reality environment). Store Manager, used to administer the 
store hierarchy, can be accessed from either Planner or Merchandiser. 

2. Support Modules 

The support modules are used for three main purposes: to configure Macro Space 
Management, to configure the varying libraries of information and to operate batch 
processes.   
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– Configuring Macro Space Management is carried out using the Administration 
module for global changes and the Configuration module for local, user specific 
changes. 

– Libraries of information maintained include the fixture and gondola libraries 
(Fixture Studio), product library (Product Studio) and the planogram library 
(planogram design within the Merchandiser module). 

– Batch tools include Data importer (for bulk import of data) and Report Designer 
(configuring planogram reports for bulk output) 

In-Store Space Collaboration 
In-Store Space Collaboration uses a common database with Macro Space Management. 
ISSC is more portable than MSM and is often deployed to stores to allow store managers 
to become involved in the store planning process. It can also be used to ensure 
compliance with store plans. It has an extension - ISSC Mobile. ISSC Mobile is designed 
for use by store associates allowing them to identify changes in fixturing and 
merchandise in the store the associate works in. 

Relationship with Third-Party Databases 
Data on products is often held in a third-party database. This data needs to be brought 
into the Macro Space Planning database so that it can be used within Macro Space 
Management and In-Store Space Collaboration. This can be imported using an ETL tool 
like Oracle Data Integrator (ODI). Product data can either be brought in as a separate 
import or as part of the planogram import process. 

Note: It is possible to return data from the Macro Space 
Planning database to the 3rd Party Product database via a 
tool like Oracle Data Integrator. One example of this might 
be returning product adjacencies, so that the performance of 
a product can be analyzed while taking into account the 
effect of other products that were close to it. 

Product Studio and the Imported Data 
Although it is possible to manually set up a product hierarchy, the majority of retail 
organizations import product information from a third party database. Product Studio 
thus serves two functions: 

1. It allows users within Macro Space Management to see full information on the 
imported products and their hierarchy. 

2. It enables Macro Space Management users to add supplementary information to that 
imported from the third-party database. 

Using Products and their Hierarchy in Macro Space Planning 
The product hierarchy is used in three places within the Macro Space Planning suite; 

1. In the MSM Planner Module where products can be placed down to SKU level as 
placeholders: this specifies that a product is on a particular fixture, but gives no 
information as to position or quantity. 

2. In the MSM Merchandiser module where products can be placed down to Display 
Style level: this specifies the position and quantity of that product on a specific 
fixture. 
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3. In In-Store Space Collaboration. Products can be placed down to Sub-class level as 
placeholders in Top Graphical View and down to Display Style level in Front 
Graphical View. 

Using Products within Planograms 
Although it is possible to place products as individual items within a floor plan, it is 
more usual to place them within planograms. Planograms enable a precise arrangement 
of shelving and merchandise to be placed in exactly the same format within multiple 
stores. This has the following benefits: 

1. Product arrangements can be standardized across a retail organization 

2. Placement of planograms is far quicker than placement of the individual equipment 
and products  

3. Specialist planogram designers can seek to maximize profitability by designing 
planograms that are as attractive as possible to customers - this is not possible if a 
store is merchandised by placing individual products. 

Displaying the Product Hierarchy in Planner, Merchandiser and ISSC 
The product hierarchy imported into and configured in Product Studio can be used to 
place products in the Planner and merchandiser Modules and in In-Store Space 
Collaboration. 

Planner and Merchandiser 
The Product Hierarchy can be seen in the Object Browsers in both the Planner and 
Merchandiser modules. All levels of the hierarchy are available, although products can 
only be placed down to SKU level in the Planner module. The example below shows the 
Object Browser in the Planner module. 
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The properties displayed are dependent on the Custom SQL in the Macro Space Planning 
Database (AVTTB_CUSTOM_SQL table). This can only be modified by an Administrator 
with database privileges. 

In-Store Space Collaboration 
The Product Hierarchy can be seen in the In-Store Space Collaboration object browser. 
The hierarchy is only displayed down to Item level in Top Graphical view, so the lowest 
levels of the hierarchy are not available for selection in that view. The full Product 
Hierarchy can be seen in Front Graphical View and Shelf Graphical View. 
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The properties displayed are dependent on the Custom SQL in the Macro Space Planning 
Database (AVTTB_CUSTOM_SQL table). This can only be modified by an Administrator 
with database privileges. 
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2 
Logging in to Product Studio 

Logging into Macro Space Management Modules 
When a user first attempts to access a Macro Space Management module, the Log In 
dialog box will appear. 

 
This requires the user to enter a User Name and Password. If these are correct, the user 
will be able to access the desired module. After the initial log in, information will be held 
in Security Server. Users will therefore be able to access all other Macro Space 
Management modules they have permissions for without the need to log in again. If the 
user enters an incorrect user name or password, a warning will result. 

 
If the user attempts to log into a module for which they do not have permissions for, a 
warning will appear and the log in attempt will be terminated. 

 

Note: The permissions for which modules can be accessed 
are configured in the Administration module. 

Password Changes 
Macro Space Management can be configured to require password changes at specified 
intervals. If one of these intervals has been exceeded, the user will be asked to change 
their password the next time they log in. This can be done by means of the Change 
Password >>> option on the Log In dialog box. This will reveal another part of the 
dialog box where the changed password can be entered and confirmed. 
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How Passwords and Privileges are Configured 
Passwords and privileges are configured in Macro Space Management's Administration 
module. 

Note: Access to the Administration Module is normally 
restricted to a limited number of users. This is because the 
Administration Module can be used to set a wide variety of 
parameters affecting how Macro Space Planning operates.   

Access rights to the Macro Space Management modules are set using the Functional 
Security option. 

 
Users are assigned to User Groups in the User Groups Tab. Which modules a User Group 
can access is specified in the Group Relationships tab. A user's privileges thus depend on 
what user groups they are assigned to. 
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In the above example, User 1 is only a member of the Equipment Planner user group. 
Accordingly, their access is restricted to the Fixture Studio and Planner modules. User 2 
is a member of the Equipment Planner and Merchandiser Planner user groups. They 
have wider access and can use the Fixture Studio, Planner, Product Studio and 
Merchandiser modules. 

Security Server 
Security Server is a Macro Space Management process that runs in the background and 
is normally not visible to users. When running, it can be seen in the Processes tab of 
Windows Task Manager as the AVT5SecurityServer.exe *32 process. 

 
How Security Server operates is shown in the following flowchart. 
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1. The user opens a Macro Space Management module from a shortcut or the Windows 
start menu. 

2. Security server starts but remains in the background. 

3. The Log In dialog box appears. 

4. The user types their user name and password into the Log In dialog box. 

5. Security Server validates the user name and password against the information held 
in the database. If they are correct and the user has sufficient privileges, the Macro 
Space Management module opens. 

6. Security Server holds information on what other privileges the user has in Macro 
Space Management. 

7. If the user attempts to access other modules, Security Server will check the 
information it holds and allow or deny access as required. This means that a user 
only has to log into Macro Space Management once per session. 

8. When the user exits the last Macro Space Management module, Security Server also 
closes. 

Security Server and Application Errors 
On occasion a Macro Space Management module might encounter a significant error and 
automatically close. Because the closure was not user initiated, Security Server does not 
close but remains open in the background. If the module that unexpectedly closed is 
reopened, Security Server will contain information incompatible with the restart and 
further application errors will result. 

In the event of a Macro Space Management module failing unexpectedly, carry out the 
following actions: 

1. Save the information in any other Macro Space Management modules that are open 
and close those modules. 

2. Open Windows Task Manager, , select the Processes tab, highlight the 
AVT5SecurityServer.exe *32 process and click End Task. 

3. When Security Server has closed, the required Macro Space Management modules 
can be restarted. 
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3 
Overview of Product Studio 

About Product Studio 
Product Studio allows users to create and maintain a hierarchy of products. This 
hierarchy is then used in the Planner and Merchandiser modules and in In-Store Space 
Collaboration. Data can be imported from third-party software, data can be manually 
entered, or some combination of the two can be used. 

 
The Menu Bar has the following options. 

File Menu 
The File Menu  gives the user access to various saving and exit options. 
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 Save - saves the currently active product definition. 

 Save All - saves all currently open product definitions. 

 Close - closes the currently active product definition. 

 Close All - closes all currently open product definitions. 

 Configure (F6) - opens the Configuration Module. 

 Exit - closes Product Studio. 

Edit Menu 
The Edit menu allows the user to modify the hierarchy. 

 
 Add - adds another level to the hierarchy, adding a child object to the currently 

selected node. 

 Edit - opens the currently selected node in the hierarchy for editing. 

 Delete - deletes the currently selected note in the hierarchy. 

 Import Product Images allows the user to bulk import product images. (This is 
discussed in more detail in the section in importing product images). 

 Cut (<Ctrl + X>) - removes the selected item from the hierarchy and puts it on the 
clipboard. 

 Copy (<Ctrl + C>) - copies the selected item in the hierarchy and puts it on the 
clipboard. 

 Paste (<Ctrl + V>) - takes the current item on the clipboard and pastes it as a child 
object to the currently selected node. 

View Menu 
The View Menu gives users access to varying information. 
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 Find - calls the Find dialogue box. 

 Refresh - refreshes the hierarchy with the latest information from the database. 

 Show Extra Info - toggles the Product Description into view as well as the Product 
Name. 

 Display Product Tree - toggles the Product Tree on or off.   

 Display Newly Imported Products - display a list of recently imported products. 

 Display Style Types enables a user to configure the list of Display Style Types. 

 Product Image Configuration enables a user to configure how the application stores 
the product images used for Display Style level merchandise. 

 Display Deleted Products - displays a list of products that have been deleted from the 
Product Tree. 

 Materials - allows users to configure the way products display in Box or Textured 
Box form in Merchandiser. 

Window Menu 
The Window Menu allows the user to arrange any dialogue boxes open in Product 
Studio. 

 
1. Tile Vertically aligns all open product dialogue boxes vertically. 

2. Tile Horizontally aligns all open product dialogue boxes horizontally. 

3. Cascade aligns all open product dialogue boxes diagonally. 

4. Minimize All minimizes all open product dialogue boxes. 

5. Restore All maximizes all open product dialogue boxes. 

Help Menu 
The Help Menu calls help and allows the user to verify the version of the software in use. 
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Overview of Product Hierarchy 
The Product hierarchy can be built up using a series of levels. Some levels are mandatory 
(solid outline) and some are optional (dotted outline). 

 
When constructing the hierarchy, there are just three dialogue boxes involved. 

Dialog box Associated Levels 

Product Company, Group, Division, Department, Class, Sub-Class, Style and Item 

SKU SKU 

Display Style Display Style 

The hierarchy is set up relative to the Product Root. It is set up in stages: 
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Stage Action 

1 Set up Company, Group, Division and Department Levels 

2 Set up Class 

3 Set up Sub-Class 

4 Set up Style, Item and SKU Levels 

5 Set up Display Styles 

Each child is added by clicking on the parent level and selecting 'Add Product' from the 
right click menu. 

Placeholders and Display Styles 
Products can be placed with varying levels of detail. 

Placeholders 
Placeholders are used at all levels in the hierarchy above Display Style level. They are 
used to show the presence of merchandise without giving any information as to its 
quantity, orientation, etc. Placeholders can be used to show represent any level from the 
product hierarchy. For example, when first planning a store, they could be used to 
represent the departments whose merchandise will be placed on specific fixtures. 
Similarly, when planning progresses to another level of detail, placeholders could be 
used to represent the sub-classes of product that will go onto specific fixtures.   

For example a placeholder could be placed at Department level to indicate that a specific 
section of equipment has been allocated for the sale of clothing. Later, this placeholder 
could be replaced by one at Class level to indicate a specific section of equipment has 
been allocated for the sale of men's shirts. In the Planner module placeholders can only 
occupy the full fixture. 
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In the Merchandiser module, placeholders can be used to represent the product types 
that will occupy a fixture (left hand fixture in the diagram below). Alternatively, they can 
be used to represent the product types that will occupy specific shelves (middle fixture). 

 

Display Styles 
Display styles describe the physical form of a SKU being placed. They can only be placed 
in the merchandiser module (right hand fixture in the diagram above). If a display style 
is placed, it gives full information on the position, number, physical form and orientation 
of the product being placed. 

Note: If Display Style level products are placed in 
Merchandiser, they will not appear in Planner. 
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Deciding on how to Identify the Product 
When setting up the Product hierarchy, it is important to have a single, unique way of 
identifying the product. This is generally determined by how the product is indexed in 
other software used by a retailer. For example, stock control and/or re-ordering systems 
might refer to the product by its UPC or by its SKU Code.  It is important that Macro 
Space Planning uses the same method of identification. If data is imported into the 
product hierarchy, this information will be included automatically. For manual entry, 
this is set by the UPC Type drop down list in the details tab of the SKU dialog box. The 
mask for these is set in the Product Code Types dialog box accessed from the 
Merchandising menu in the Administration Module. 

 

Deciding on the structure of the hierarchy 

General 
The generic hierarchy can have up to 10 levels, 5 of them mandatory: 

Level Comment 

Company Optional 

Group Optional 

Division Optional 

Department Mandatory 

Class Mandatory 
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Level Comment 

Sub-Class Mandatory 

Style Optional 

Item Optional 

SKU Mandatory 

Display 
Style 

Mandatory 

 

As product data will be generally imported from third-party software, the required 
Macro Space Management hierarchy should be planned before the first import so that 
data is imported into a standardized hierarchy. 

Note: There will be problems with the Macro Space 
Management Data Import module if the hierarchy does not 
conform to a standard architecture. 

Making the Hierarchy User Friendly 
The Product Hierarchy consists of a series of levels which should be laid out in a way 
convenient for and familiar to store planners. 

 
Configuring the hierarchy in the optimum manner can save considerable time and effort 
when products are being placed in Macro Space Management store plans. 

Note: Any level in the hierarchy can be renamed to customer 
requirements by Oracle. 
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'Unknown' Levels in Hierarchy 
The Product hierarchy contains nodes called Unknown Category, Unknown class, 
Unknown Sub-Class, and Unknown Sub-Sub-Class. 

 
These nodes in the hierarchy are used for when products are imported prior to importing 
new planogram designs. It may be that some of the products being imported do not map 
to existing nodes in the product hierarchy. 
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4 
Interactions between Product Studio and 

Other Modules 
Product Studio and Other Modules 

Product Studio interacts with other Modules and with In-Store Space Collaboration. 

 

Administration Module 
A number of lists of data used in Product Studio are configured in the Administration 
Module. 

Option Comment 

Category Role Allows the user to configure the list of Category Roles that can be assigned 
to a product. 

Manufacturers Allows the user to configure the list of manufacturers (and suppliers) used 
to specify products. 

Product Code Types Allows the user to specify the masks for UPC's. 

Ranges Allows the user to configure the ranges for temperature scales and weights 
that can be allocated to a product. 

Strategy Allows the user to configure the list of Category Roles that can be assigned 
to a product. 

Tax Codes Allows the user to configure the list of available Tax Codes that can be 
allocated to a product. 

Styles Allows the user to add, edit or delete styles for products. 

Units Allows users to configure the units used for defining products.  

User Defined 
Attributes 

Allows users to specify the User Defined Attr ibutes required for products. 
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In addition, Products marked for deletion can only be permanently purged using the 
Purge option in the Administration Module. 

Configuration Module 
The locations of the directories for Image Capture and Image Root are specified in the 
Directories tab in the Configuration Module. 

Data Import 
Data can be imported from third-party software by with the Data Importer module, or by 
using Oracle data Integrator (ODI). If necessary, it can then be configured with additional 
information required by Macro Space Management. 

Planner 
The Product Hierarchy appears in the Object Browser and can be searched/selected from 
using the Object Grid. Products can be placed down to SKU level as placeholders. 

Merchandiser 
The Product Hierarchy appears in the Object Browser and can be searched/selected from 
using the Object Grid. Products can be placed down to SKU level as placeholders or as 
Display styles. 

In-Store Space Collaboration 
The Product Hierarchy appears in the Object Browser. Products can be placed down to 
Item level as placeholders  

Administration Module 
A number of lists, etc, used in Product Studio are configured in the Administration 
Module. In addition, Products marked for deletion can only be permanently purged 
using the Purge option in the Administration Module. 

Note: Only users with the appropriate privileges may 
directly access the Administration module. However, the 
lists of Manufacturers and Styles can be configured by users 
with access rights to Product Studio. 

 

Option Comment 

Category Role Allows the user to configure the list of Category Roles that can be assigned 
to a product. 

Manufacturers Allows the user to configure the list of manufacturers (and suppliers) used 
to specify products. 

Product Code Types Allows the user to specify the masks for UPC's. 

Ranges Allows the user to configure the ranges for temperature scales and weights 
that can be allocated to a product. 



Administration Module 

Interactions between Product Studio and Other Modules 23 

Option Comment 

Strategy Allows the user to configure the list of Category Roles that can be assigned 
to a product. 

Tax Codes Allows the user to configure the list of available Tax Codes that can be 
allocated to a product. 

Styles Allows the user to add, edit or delete styles for products. 

Units Allows users to configure the units used for defining products.  

User Defined 
Attributes 

Allows users to specify the User Defined Attr ibutes required for products. 

Category Role 
The list of Category Roles is configurable from the Merchandising menu in the 
Administration module. This will bring up the Category Role dialog box, allowing users 
to add, edit or delete from the list of Category Roles. 

 

Manufacturers 
The list of manufacturers is configurable from the General Menu in the Administration 
module. This option is only available for users with permission to access the 
Administration module.  As an alternative, the option may also be accessed from the 
Product Studio module by clicking the button to the right of the Manufacturers drop 
down list in the product hierarchy at any level from Company to Style. 
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This will bring up the Manufacturers dialog box from the Administration module, 
allowing users to add, edit or delete from the list of manufacturers. 

 
 

Option Comment 

Name Name of the manufacturer 

Code Code for the manufacturer - often used as a look up during data import 

Type Type is set to either Fixtures or Products using the drop down list  

 

Note: It is recommended that changes are only made to the 
list of manufacturers after consultation with an 
Administrator. This is because such changes could affect the 
import of data from a third-party database. 
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Product Code Types 
Product Code Types are only configurable within the Administration Module. They are 
accessed from the Merchandising Menu. 

 
It enables the masks restricting entry of SKU codes at SKU level in the product hierarchy 
to be configured. The mask can then be selected using the UPC Type drop down list in 
the Details tab of the SKU dialog box. This mask then applies to all manually entered 
SKU information in the SKU dialog box. 

 
1. The UPC type can be set from the drop down list. 

2. All manually entered codes must then conform to the mask specified in the Admin 
module. 

Note: the UPC mask will not be applied to data imported 
into the product hierarchy. 
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Ranges 
Ranges can be assigned to equipment (fixtures and shelf objects) and to merchandise 
(products at SKU level). When merchandise at SKU or Display Style level is added to a 
fixtures or shelf object in the Merchandiser module, the assigned temperature ranges are 
compared. If they differ, the merchandiser cannot be placed and a warning will be 
generated. Ranges are configured using the Range option from the Merchandising Menu 
in the Admin Module. 

 
Once configured, temperature ranges can be assigned to products in Product Studio by 
using the drop down list in the Physical Tab of the SKU dialog box. 

 
Ranges assigned at SKU level also apply to any associated Display Style products. 

Strategies 
The list of Strategies is configurable from the Merchandising menu in the Administration 
module. This will bring up the Strategy dialog box, allowing users to add, edit or delete 
from the list of Strategies. 
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Styles 
Styles are used when placing products at Display Style level in the Merchandiser 
module. They serve as filters to ensure that products are placed on the appropriate items 
of equipment. For example, Ice Cream should only be placed in Freezer units, and not on 
open shelving. The list of Styles is configurable in the Administration Module. The 
option may also be accessed from the Product Studio module by clicking the button 
above the Available styles pane in the Styles tab of the Display Style dialog box. 
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This will bring up the Styles dialog box. 
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This dialog box has three tabs: 

1. Style Tab - where the names and types of styles are configured 

2. Style Relationships Tab - where the relationships between styles are determined: in 
turn specifying what merchandise can go on what item of equipment 

3. Test Tab - this tab allows users to determine what product styles can be placed on an 
item of equipment. It also allows a user to determine what equipment an item of 
merchandise can be placed on. 

Note: It is recommended that changes are only made to the 
list of styles and style relationships after consultation with 
an Administrator. This is because such changes could 
significantly affect how products at Display Style level place 
in the Merchandiser Module. 

Tax Codes 
Tax Codes can be assigned to products at SKU level. They are configured using the Tax 
Codes option from the General menu in the Administration module. 
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Once configured, Tax Codes can be assigned to products in Product Studio in the Tax 
Code drop down list of the Financial Tab of the SKU dialog box. 

 
The Tax Code can then be used for calculation or reporting purposes. 

Units 
The Units dialog box is accessed from the General menu of the Administration Module. 
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It can be used to configure the varying units used in Macro Space Planning. Within 
Product Studio, these are directly used in two places: 

1. The Currency set using the drop down list in the Financial tab of the SKU dialog box. 

 
2. The weights and dimensions set in the Size and Shape tab of the Display Style dialog 

box. 
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User Defined Attributes 
User Defined Attributes are configured in the UDA (User Defined Attributes) dialog box 
accessed from the General menu in the Admin Module. 

 
Once configured for products, UDA's can be assigned in the Custom Tab of the SKU 
dialog box. 
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Configuration Module 
The locations of the directories for Image Capture and Image Root are specified in the 
Directories tab in the Configuration Module. 
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1. Image Capture is where images are stored after being captured by a camera. 

2. Image Root is the starting point for storage of images after they have been assigned 
to a product. 

Image Capture 
Image Capture is where images that have been taken with a digital camera or scanned 
are stored prior to being imported into Macro Space Planning. The image capture 
directory may be either local or on a server. If on a server, images have to be uploaded to 
the server before they can be imported into Macro Space Planning 

Image Root 
The Image Root is always a folder on a server. It serves as the starting point or the 
directories that hold the images associated with Display Styles. 

Importing Images 
Images may be imported either manually or automatically. Manual image import is done 
via the Images tab on the Display Style dialog box. 

 
On clicking the Import button, any images that at in the Image Capture directory with a 
name matching that specified in the Product Image Configuration dialog box will be 
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moved to the appropriate sub-directory under the Image Root. Alternatively, on clicking 
the Browse for Image button, users will be taken to the Image Capture directory. After 
selecting an image it can be 'dragged and dropped' into one of the six boxes on the right. 
After being dragged and dropped, the image will be converted to jpg format and stored 
in a directory originating from the Image Root. 

Note: See the Configuration Module Help File for more 
information on how Directories and their paths are 
configured. 

Data Import 
Macro Space Management provides a specialized Data Import module. This allows 
product details to be imported from third-party software. 

 
The way this is done is as follows: 

 
 

1. Data from a third-party database containing product information is written to a flat 
file (CSV file or fixed Width File). 

2. This flat file is read by Data Importer and the information written to tables in the 
Macro Space Planning database. 

3. The information in the Macro Space Planning database is displayed in the product 
hierarchy. 

It may be necessary to add other information to the imported data. This could include 
information such as dimensions, style relationships or images for 3D Virtual Reality 
representation in Merchandiser. 

Note: Product information can also be imported as a 
separate process (independent of Data Importer) during the 
Planogram Import process using Oracle Data Integrator 
(ODI) 
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Planner and Merchandiser 

Planner 
The Product hierarchy appears in the Object Browser in Planner. It can also be searched 
using the Object Grid. 

 

Products can then be placed down to SKU level as placeholders. 

Merchandiser 
Like Planner, the Product hierarchy appears in the Object Browser in Merchandiser. It 
can also be searched using the Object Grid. 
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The Product hierarchy can either be placed as placeholders down to SKU level, or as 3D 
Virtual Reality objects at the Display Style level. 

In-Store Space Collaboration 
The product hierarchy is also shown in the Browser in the In-store Space Collaboration 
application. 
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The hierarchy is only displayed down to Item level. 
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5 
Importing the Product Hierarchy 

Importing the Product Hierarchy 
Although it is possible to manually create a product hierarchy, it is more normal to 
import that product hierarchy. This is generally done by using the Data Importer module 
to import information from a third-party database containing product information. This 
import operation can be invoked manually, but it is more normal for it to be run 
automatically using a batch scheduling tool. 

Planograms 
Before planogram designs involving new products are imported into Macro Space 
Planning, any new products required for those planograms must first be imported into 
the product hierarchy. This is done separately from a pure product import as it is done as 
part of the planogram import process as one of the stages of bringing in planogram 
designs using ODI (Oracle Data Integrator). 

Frequency of updates 
The frequency of updates will determine how current the information is in Product 
Studio compared to the third-party database the information is being imported from. The 
frequency of imports is in its turn determined by the available time to carry out that 
import. If the time is available, product data might be imported on a nightly basis. If time 
overnight is restricted by the need to carry out other batch tasks, then it might only be 
possible to import updated product information at the weekends. 

Note: As the frequency of updates will vary from retail 
organization to retail organization, import frequency should 
be checked with an administrator if required. 

Information updated 
Information on products held in the Macro Space Planning (MSP) database can be 
updated in varying ways. These include: 

1. New Products 

Entirely new products can be imported into the MSP database. Examples of this 
might include new products from existing suppliers, or existing products being 
sourced from different suppliers. 

2. Updated Products 

Product information on existing products can be updated. Examples of this might 
include changes to financial information or to UDAs (User Defined Attributes). 

3. Expired Products 

Products can be expired (removed from the list of those available). This is done by 
setting an expiry date for the product. When placing products in a floor plan, the 
expiry date is compared with the Active Date for the floor plan. (This Active Date can 
be set at the top of the Object Browser if the floor plan is open - alternatively, it can 
be set in the File Properties dialog box for the floor plan in store Manager). 
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If the Expiry Date for the Product is before the Active Date for the floor plan, the 
product cannot be placed as it will be obsolete before the floor plan comes into 
service. 

Expired products can be purged using the Purge option on the Tools menu in the 
Admin Module. Products will only be purged (deleted from the database) if there are 
no instances of that product in any floor plans (including those at historical status). 

Importing Products with Planogram Import 
Before planogram designs involving new products are imported into Macro Space 
Planning, any new products required for those planograms must first be imported into 
the product hierarchy. This is done separately from a pure product import as it is done as 
part of the planogram import process as one of the stages of bringing in planogram 
designs using ODI (Oracle Data Integrator). 
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6 
Importing Product Images 

Overview of Importing Product Images 
There are two ways of importing product images. 

 

Import Image 
This option is semi automatic and invoked by clicking the Import button. If an image of 
the correct name exists in the Image Root specified in the directory tab of the 
Configuration module, clicking the Import button will result in the image being moved 
or copied to the folder under the Image Root specified by the setting in the Configuration 
Module. 
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Browse for Image 
Clicking Browse for Image allows the user to manually browse for an image to associate 
for the product. The initial directory opened will default to that specified for Image 
Capture in the Directories Tab of the Configuration Module. 

Product Image Configuration 
The names the product images are stored under are determined in the Product Image 
Configuration dialog box accessed from the View menu. 

 

Filename Based On 
This radio button determines the name that will be assigned to the image after it has been 
imported. 

1. SKU Code 

The image will be named after a combination of the Display Style type, the SKU code 
and the direction the image will be facing. 

– The first character in the image name indicates the Display Style Type. This 
information is read from the information specified in the Display Style Type 
dialog box accessed from the View menu and will be the single letter in the 
Name Field. 

 
– The next characters in the image name will be the SKU code. 

– The final two characters in the image name denote the direction the image will be 
viewed from when placed on a display style. 
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Character View Direction 

_1 Front 

_2 Left 

_3 Top 

_4 Back 

_5 Right 

_6 Bottom 

 

M12345678__3 is therefore the image name for a multi-pack display style that will be 
displayed on top of the display style when it is represented in the Merchandiser module. 

Note: The SKU Code is stored in the Client Code field in the 
SKU and display Style dialog boxes. 

2. UPC Code 

The image will be named after a combination of the Display Style type, the UPC 
Code and the direction the image will be facing. 

– The first character in the image name indicates the Display Style Type. This 
information is read from the information specified in the Display Style Type 
dialog box accessed from the View menu and will be the single letter in the 
Name Field. 

– The next characters in the image name will be the UPC code. (This could be in a 
number of formats: for example EAN or GTIN). 

– The final two characters in the image name denote the direction the image will be 
viewed from when placed on a display style. 

3. Product Description 

The image will be named after the Product Description in the Display Style dialog 
box. 

H5000237091807_1 is therefore the image name for a multi-pack display style that 
will be displayed on the front of the display style when it is represented in the 
Merchandiser module. 

Note: These options will be configured when Macro Space 
Planning is implemented. If the settings are changed after 
images have been imported, the application will look for 
images corresponding to the changed settings and all 
association with images associated with the old settings will 
be lost. 

Image Sub-Directories 
Image sub-directories will be located under the Image Root specified in the Directories 
tab of the configuration module. 

1. SKU Code 

If SKU Code is selected, the image sub directories will be named after the first 1 - 3 
characters of the SKU code depending on the setting on the spin control. 

2. UPC Code 
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If UPC Code is selected, there are two options that can be used. 

– If Number of Characters is selected, the image sub directories will be named after 
the first 1 - 3 characters of the UPC code depending on the setting on the spin 
control. 

– If Manufacturer is selected, the image sub-directory will be named after the 
digits within the UPC code that represent the manufacturer. 

3. Product Description 

If SKU Code is selected, the image sub directories will be named after the first 1 - 3 
characters of the product description at display style level depending on the setting 
on the spin control. 

Note: These options will be configured when Macro Space 
Planning is implemented. If the settings are changed after 
images have been imported, the application will look for 
images corresponding to the changed settings and all 
association with images associated with the old settings will 
be lost. 

In the example below, image folders based on the Product Description have been 
created below the Image Root. 

 

Options 
If the Copy Files from capture directory to Image Root option is checked, a copy of the 
image file will be placed in the image sub-directory below the Image Root. If unchecked, 
the image file will be moved from the Image Capture directory to the specified image 
sub-directory. 

Manually Importing Images 
Images can be added to a Display Style level product. This is done by clicking Browse for 
Image on the Images tab of the Display Style dialog box. Images can be of the jpg, jpeg, 
bmp, gif, tif and tiff formats. 

Note: Images are used in an 'associative' fashion in the 
Merchandiser module - no record is stored in the database, 
but the application looks for images for specific name stored 
in a specific directory when representing the display style in 
a floor plan. The Image Name and directory are based in 
settings in the Product Image Configuration dialog box 
accessed from the View menu. 
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The required image should be in the Image Capture directory specified in the 
Configuration module. On clicking Browse for Image the Browse for Image dialog box 
will open. The required image can then be selected. 
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When the Open button is clicked, the image will appear in the left pane in the Display 
Style dialog box. It can then be 'dragged and dropped' to where it is needed on the 
product sides.  The number of images required for each product will depend on settings 
in the Product Image Configuration dialog box. If the SKU or UPC options are chosen, up 
to six images can be associated, each associated with one side of a cube. If the Description 
option is chosen, only one image can be associated - with the front of the Display style. 

As the image is 'dragged and dropped' it will be moved to the required folder under the 
specified Image Root. The name of the image will be changed to the format specified in 
the settings in the Product Image Configuration dialog box (View menu) and the format 
of the image will also be converted to jpg. 

Note: The options will be configured Product Image 
Configuration dialog box when Macro Space Planning is 
implemented. If the settings are changed after images have 
been imported, the application will look for images 
corresponding to the changed settings and all association 
with images associated with the old settings will be lost. 

Importing Images 
Images are used in an 'associative' fashion in the Merchandiser module - no record is 
stored in the database, but the application looks for images for specific name stored in a 
specific directory when representing the display style in a floor plan. The image name 
and directory are based in settings in the Product Image Configuration dialog box 
accessed from the View menu.  

Import for a specific Product 
Semi-Automatic import is used to import the images associated with a specific product at 
display style level. For this process to work there must be an image in the Image Capture 
directory specified in the Configuration Module with a name that matches that specified 
by the settings in the Product Image Configuration dialog box. When the Import button 
is clicked on the Images tab of the Display Styles dialog box, that image will be moved or 
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copied to the sub-directory below the Image Root specified by the settings in the Product 
Image Configuration dialog box. 

 
The results will be reported in a dialog box. 

 
If the option in the Product Image Configuration dialog box was set to SKU Code or UPC 
Code, up to 6 images can be imported for each display style. If the option is set to 
Product Description, only a  single image will be imported. 
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Note: Care needs to be taken that there are no trailing spaces 
in the field that is used to determine the image name. For 
example if the image name is to be based on the display style 
description, if the description has trailing spaces the import 
will fail. 

Full Import 
The alternative method is to bulk import images. If there is an image in the Image 
Capture directory specified in the Configuration Module with a name that matches that 
specified by the settings in the Product Image Configuration dialog box, when the 
Import Product Images option on the view menu is clicked that image will be moved or 
copied to the sub-directory below the Image Root specified by the settings in the Product 
Image Configuration dialog box. 

Note: Unlike the import button in the Images tab of the 
Display Styles dialog box, this will import  images for all 
products that match the specified criteria. 

 
The results will be reported in a dialog box. 
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7 
Using Transparency in Product Images 

Overview of Transparency and Product Images 
Note: An alternative to using the technique described in the 
section below is use the ability in most image processing 
software to turn the background of an image transparent. 
This will mean the background will not display in Macro 
Space Planning, leaving only the product itself on display. 
Consult the help files of your image processing software for 
more information. 

Product Studio gives user the option of turning specific parts of the image transparent 
when displayed.   

 
The television on the left has had parts on the image made transparent; the television on 
the right has not. Making parts of images transparent can make display styles look more 
realistic in the Merchandiser module. The process of making parts of images transparent 
is outlines in the flow chart below. 

 
1. The DEFAULT_TRANSPARENCY_COLOUR system variable in the Administration 

module is set to a precise RGB value. 

2. The parts of the product image to be made transparent are colored the precise RGB 
value 

3. The image is imported into Product Studio 

4. The image is assigned to a Display Style 

5. When this Display Style is used in Merchandiser, the specified parts of the image will 
appear transparent. 

 



Setting the DEFAULT_TRANSPARENCY_COLOUR System Variable 

50 Oracle Retail Macro Space Management 

Setting the DEFAULT_TRANSPARENCY_COLOUR System Variable 
Note: An alternative to using the technique described in the 
section below is use the ability in most image processing 
software to turn the background of an image transparent. 
This will mean the background will not display in Macro 
Space Planning, leaving only the product itself on display. 
Consult the help files of your image processing software for 
more information. 

The DEFAULT TRANSPARENCY_COLOUR System variable is set in the 
Administration module. Only users with the appropriate privileges can access this 
module. The system variable is set by selecting the System Variable option from the 
General menu to bring up the System Variable dialog box. 

 
The system variable is set by entering decimal equivalent of an RGB (Red, Green, Blue) 
value into the Value text box, pressing Return and exiting the dialog box. The decimal 
equivalent of the RGB value can be obtained by opening any dialog box in the product 
hierarchy in Product Studio - the example below is at Sub-class level. 
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The color value (expressed as a decimal equivalent) can be seen as a color value in the 
text box. In the above example, it is 16711935. To find the RGB equivalent click the Color 
Button . This will open the Color dialog box. Clicking the Define Custom Colors >>> 
button will expand the dialog box. The RGB values can be seen towards the right. 

 
In the above example the RGB vales are as follows: Red = 255, Green = 0 and Blue = 255. 
These values define a Magenta shade. 

Note: To convert RGB values to the single value stored in the 
database, apply the following formula: DB Value = Red 
Value + (Green Value x 256) + (Blue Value x 63536). 
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Preparing the Image 
Note: An alternative to using the technique described in the 
section below is use the ability in most image processing 
software to turn the background of an image transparent. 
This will mean the background will not display in Macro 
Space Planning, leaving only the product itself on display. 
Consult the help files of your image processing software for 
more information. 

In order to prepare the image, parts of it must be colored the precise RGB value specified 
in the DEFAULT_TRANSPARENCY_COLOUR system variable. This can be done with 
most photo editing software. (The example below is from Microsoft's Paint  program).Set 
the color to be added to the precise RGB values. 

 
The areas of the image to be made transparent can then be filled with the precise shade of 
color. 

 
In the example above, the area by the base of the TV is to be made transparent and has 
been colored accordingly. Once colored, the image must be saved as a bit map (.bmp 
extension). This is because bit map images save colors more accurately than a jpg image. 
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Adding the Image to a Product 
Note: An alternative to using the technique described in the 
section below is use the ability in most image processing 
software to turn the background of an image transparent. 
This will mean the background will not display in Macro 
Space Planning, leaving only the product itself on display. 
Consult the help files of your image processing software for 
more information. 

The bit map image can now be added to a Display Style level product. This is done via 
the Images tab of the Display Style dialog box. 

 
The image (with added transparency color) should be in the Image Capture directory 
specified in the Configuration module. On clicking Browse for Image the Browse for 
Image dialog box will open. The required image can then be selected. 
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When the Open button is clicked, the image will appear in the left pane in the Display 
Style dialog box. It can then be 'dragged and dropped' to where it is needed on the 
product sides. 

Note: The number of images required for each product will 
depend on settings in the Product Image Configuration 
dialog box. 

As the image is imported into the appropriate folder under the Image Root in the 
windows folder structure, it will be converted from a bit map file (.bmp) to a .jpg file. 
Every time the image is changed, it must be done as a fresh .bmp file as jpg files do not 
store RGB colors as precisely. Re-saving the .jpg file after editing it will almost certainly 
change the value of the transparency color to one different from that specified in the 
DEFAULT_TRANSPARENCY_COLOUR system variable and the colored areas will not 
appear transparent. 
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8 
Setting up the Basic Hierarchy 

Setting up Company, Group, Division and Department Levels 
Company, Group, Division and Department Levels are set up starting from the Product 
Root using the Product dialog box. Additional levels can be added using the Add option 
from the Edit menu or the right click menu. 

 
The Hierarchy Level Type can be set using the Type drop down list. The options are in 
the following sequence: 

 Company (Optional) 

 Group     (Optional) 

 Division   (Optional) 

 Department (Mandatory) 

Once a level has been added, its child will only be available from those levels below it in 
the hierarchy. Only when a Department has been added will the Class option be 
available in the drop down list of Hierarchy Level Types. 

Parameter Comment 

Name The Name is the name of the Company, Group, Division or Department. 

Description The Description is a more informative version of the name. 

Brand The Brand field is used if the children of this node in the product hierarchy 
belong to an identified brand of merchandise - for example 'Acme Clothing'. 
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Parameter Comment 

Code The Code is a client specified identifier for this item in the product hierarchy. It 
would generally contain an item of data from the database the product 
information is imported from. For example, it could be the primary key from a 
table in the third-party database. This item of data enables the data to be 
referenced back to the third-party database. If planograms are being imported, 
and this node in the hierarchy is being used as a placeholder in a planogram, it is 
assumed this field is unique. 

Client Code The Client Code is another client specified identifier for this item in the product 
hierarchy. It would generally contain an item of data from the database the 
product information is imported from. For example, it could be the primary key 
from a table in the third-party database. This item of data enables the data to be 
referenced back to the third-party database. 

Category 
Role 

This option is grayed out and unavailable for these levels in the product 
hierarchy 

Strategy This option is grayed out and unavailable for these levels in the product 
hierarchy 

Manufacturer The Manufacturer can be set from the drop down list. The drop down list is 
configured using the Manufacturers option in the Administration module.  

Supplier The Manufacturer can be set from the drop down list. The drop down list is 
configured using the Manufacturers option in the Administration module. 

Status The status shows where product is in its life cycle. It can be set from the drop 
down list - the options in this list are configured using the Status option in the 
Administration module. 

Color The color can be set from a standard color pallet. When the product is placed in 
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using 
this color. 

Icon The icon is set by default when the hierarchy level is first created, but can be 
manually set from the drop down list  

Setting up Class and Sub-Class Levels 
A Class level in the Products hierarchy can only be set up as a child of a Department and 
a Sub-class level in the Products hierarchy can only be set up as a child of a Class. Both 
levels are mandatory in the hierarchy, and both are configured by means of the Products 
dialog box. They are using the Add option from the Edit menu or the right click menu. 
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Only when a Sub-class has added will the next three options be available in the drop 
down list of Hierarchy Level Types. 

Parameter Comment 

Name The Name is the name of the Company, Group, Division or Department. 

Description The Description is a more informative version of the name. 

Brand The Brand field is used if the children of this node in the product hierarchy 
belong to an identified brand of merchandise - for example 'Acme Clothing'. 

Code The Code is a client specified identifier for this item in the product hierarchy. It 
would generally contain an item of data from the database the product 
information is imported from. For example, it could be the primary key from a 
table in the third-party database. This item of data enables the data to be 
referenced back to the third-party database. If planograms are being imported, 
and this node in the hierarchy is being used as a placeholder in a planogram, it is 
assumed this field is unique. 

Client Code The Client Code is another client specified identifier for this item in the product 
hierarchy. It would generally contain an item of data from the database the 
product information is imported from. For example, it could be the primary key 
from a table in the third-party database. This item of data enables the data to be 
referenced back to the third-party database. 

Category 
Role 

This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Category Roles are used to assign what the retailer believes is the 
reason customers purchase specific products. 

Strategy This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Strategies are used to assign what the retailers' business objectives are 
to the products that will be used to accomplish them. 
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Parameter Comment 

Manufacturer The Manufacturer can be set from the drop down list. The drop down list is 
configured using the Manufacturers option in the Administration module. 

Supplier The Manufacturer can be set from the drop down list. The drop down list is 
configured using the Manufacturers option in the Administration module. 

Status The status shows where product is in its life cycle. It can be set from the drop 
down list - the options in this list are configured using the Status option in the 
Administration module. 

Color The color can be set from a standard color pallet. When the product is placed in 
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using 
this color. 

Icon The icon is set by default when the hierarchy level is first created, but can be 
manually set from the drop down list  

Setting up Style, Item and SKU Levels 
Style, Item and SKU Levels are set up based on the Sub-Class level in the hierarchy. To 
add a Hierarchy level, complete the following steps: 

1. Right-click and select Add. The Hierarchy Level dialog box will open. 

2. Using the drop down list, select one of the following Hierarchy Level Types: 

– Style (Optional) 

– Item (Optional) 

– SKU (Mandatory) 

 
– From Sub-Class level, the user will be able to add either Style, Item or SKU 

levels. 

– From Style level the user will be able to add either Item or SKU levels. 

– From Item level the user will only be able to add SKU level merchandise. 

Once a level has been added, only its child levels may subsequently be added. For 
example, if a user at Sub-class level adds Item as the next level in the hierarchy, it 
will no longer be possible to add a Style level above it in that level of the hierarchy. If 
Style or Item levels are added in the hierarchy, the Product dialog box will appear. 
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Parameter Comment 

Name The Name is the name of the Company, Group, Division or Department. 

Description The Description is a more informative version of the name. 

Brand The Brand field is used if the children of this node in the product hierarchy 
belong to an identified brand of merchandise - for example 'Acme Clothing'. 

Code The Code is a client specified identifier for this item in the product hierarchy. It 
would generally contain an item of data from the database the product 
information is imported from. For example, it could be the primary key from a 
table in the third-party database. This item of data enables the data to be 
referenced back to the third-party database. If planograms are being imported, 
and this node in the hierarchy is being used as a placeholder in a planogram, it is 
assumed this field is unique. 

Client Code The Client Code is another client specified identifier for this item in the product 
hierarchy. It would generally contain an item of data from the database the 
product information is imported from. For example, it could be the primary key 
from a table in the third-party database. This item of data enables the data to be 
referenced back to the third-party database. 

Category 
Role 

This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Category Roles are used to assign what the retailer believes is the 
reason customers purchase specific products. 

Strategy This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Strategies are used to assign what the retailers' business objectives are 
to the products that will be used to accomplish them. 

Manufacturer The Manufacturer can be set from the drop down list. The drop down list is 
configured using the Manufacturers option in the Administration module.  
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Parameter Comment 

Supplier The Manufacturer can be set from the drop down list. The drop down list is 
configured using the Manufacturers option in the Administration module. 

Status The status shows where product is in its life cycle. It can be set from the drop 
down list - the options in this list are configured using the Status option in the 
Administration module. 

Color The color can be set from a standard color pallet. When the product is placed in 
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using 
this color. 

Icon The icon is set by default when the hierarchy level is first created, but can be 
manually set from the drop down list  

If a SKU Level Item is added, the SKU Dialog box will appear. This dialog box is 
discussed in more detail in the section on SKU Level information. 

 

Setting up Display Styles 
Display Styles are set up below the SKU level in the hierarchy. To set up a display style, 
select the pertinent item at SKU level in the hierarchy, then use Add from the edit menu 
or right click menu. 
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This dialog box is discussed in more detail in the section on Display Style information. 
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9 
SKU Level Information 

Details Tab 
The SKU Information is used to configure the information for a specific unit of sale. 
There are four tabs, each holding a different category of information. The Details Tab is 
used to configure the details for the product. 

 
 

Parameter Comment 

Name The SKU name 

Description A description of the SKU 

UPC Type UPC type can be set from a drop down list. The list can be configured using the 
Product Code Type option in the Administration Module. 

Code The Code for the product. 

UPC The UPC for the product - it must conform to the mask set in UPC type option.   

Category 
Role 

This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Category Roles are used to assign what the retailer believes is the 
reason customers purchase specific products. 
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Parameter Comment 

Strategy This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Strategies are used to assign what the retailers' business objectives are 
to the products that will be used to accomplish them. 

Manufacturer Selected from the drop down list - the list can be configured using the 
Manufacturers option in the Administration module. 

Supplier Selected from the drop down list - the list can be configured using the 
Manufacturers option in the Administration module. 

Status Selected from the drop down list - the list can be configured using the Status 
option in the Administration module. 

Icon Selected from the drop down list - the available icons are pre-loaded with the 
application and cannot be altered. 

Brand The Brand for the product. This might be the manufacturer of a brand of cereals - 
such as 'Acme Clothing'. 

Sub Brand The sub-brand for the product. This might be a sub division of a brand - such as 
Cornflakes 

Client Code The Client Code for the product - this equates to the SKU code. 

Client 
Barcode 

The Client Barcode for the product. 

Publish Date  This is the date at which the ordering of this SKU can begin. For example, if this is 
a new product it could be available for ordering from 1st June 

Effective 
Date 

This is the date that the product will be available for use within stores. This date 
would be later than the Publish date and would take into account the delay in the 
supply chain before it could appear in a store. For example, if the earliest date the 
product could be ordered is 1st June, the effective at might be set to 1st July. 

Expiry Date This is the date at which the product will be removed from use within stores. This 
date would be set (or updated) if this SKU is being superseded by another 
product. 

Rank Rank is an integer that can be used to rank SKUs in order of preference. It is 
primarily of use in the Object Grid, where it can be used as a method of selecting 
one SKU in preference to another. (Whether the rank displays in the Object Grid 
is dependent on the custom SQL being used - this can only be changed by an 
Administrator with database rights). 

The Effective Date and Expiry Date can also be used to control whether products can be 
selected from the Object Browser. This is controlled by the 
MERCH_TREE_EFFECTIVE_DATE System Variable. If set to 0 (Off), the Effective Date 
and Expiry Date will have no effect on whether products can be selected or not. If set to 1 
(On), products with an Effective Date and an Expiry Date after the Active date for the 
floor plan (set at the top of the Object Browser, or in the File Properties dialog box in 
Store Manager) will be grayed out in the Object Browser and cannot be selected. The 
Effective Date and Expiry Date can also be used to control whether products can be 
selected from the Object Grid. This depends on the custom SQL being used - this can 
only be changed by an Administrator with  database rights).  In addition, there is some 
read only information. 
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Parameter Comment 

Import 
Identifier  

This fie ld contains an item of data from the database the product information is 
imported from. For example, it could be the primary key from a table in the third-
party database. This item of data enables the data to be referenced back to the 
third-party database. 

Import 
Name 

This fie ld contains an item of data from the database the product information is 
imported from. For example, it could be a table name from in the third party 
database. This item of data enables the data to be referenced back to the third-
party database. 

Import Date This is assigned during data import and identifies date of the specific import that 
brought in or modified the product information. 

Creation 
Date 

This identifies the date the product information was imported. 

Created By This identifies the user who executed the import that brought in the product 
information. 

Last 
Modified 
Date 

This identifies the date the product information was last modified 

Last 
Modified by 

This identifies the user who last updated the product information. 

Physical Tab 
The Physical Tab is used to specify details concerning the physical aspects of the SKU. 
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Parameter Comment 

Pack size The pack size is the number of items in a pack of the product - it can be set to any 
positive numerical value. (Whether the SKU is a single item or a pack is set using 
the Cost Basis drop down list in the Financial tab. 

Pack Units This is set from a drop down list - the list can be configured using the Units 
option in the Administration Module. 

Color The color can be set from a standard color pallet. When the product is placed in 
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using 
this color. 

Nominal 
Color 

This fie ld can hold a text description of the product's color - such as Red, Green 
or Blue. It can be used for information purposes. 

Nominal Size This fie ld can hold a text description of the product's size - such as small, 
medium or large. It is used for information purposes. 

Hatch Style This fie ld can hold a hatch style for when a floor plan is printed with this product 
placed. It is currently not implemented. 

Flavor This fie ld can hold a text description of the product's flavor - such as Peppermint 
or Vanilla. It is used for information purposes. 

Gender This fie ld can hold a text description of the gender the product is intended for - 
such a Male, Female or None. It is used for information purposes. 

Temperature 
Range 

The temperature range specifies the temperature the product should be stored 
and displayed at. For the product to place in Merchandiser the fixture or shelf 
object it is to be placed on must have an identical temperature range assigned. 
Temperature ranges are configured using the Ranges option on the 
Merchandising menu in the Administration module. 

Max, Min 
and Units 

These read only values show the maximum and minimum temperature the 
product should be stored and displayed at. It also shows the units those 
temperatures are displayed in. Temperature ranges are configured using the 
Ranges option on the Merchandising menu in the Administration module. 

The text fields such as Nominal Color and Nominal Size can be used within the Macro 
Space Planning application. For example, the information could be displayed in the 
Summary Window of the Object Browser, or displayed in the Object Grid and used as 
filter for selection. 

Note: Changes to what is displayed in the Object Browser or 
Object Grid can only be made by changing the Custom SQL 
in the Macro Space Planning database. This option is only 
available to Database Administrators. 

Financial Tab 
The Financial Tab is used to record financial information on the SKU. Typically this will 
be 'static' data based on organization wide averages. More specific information is often 
brought in with the Product UDA information for planograms. 
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Note: The precise definition of some of the terms described 
below varies from retail organization to retail organization. 

  

Parameter Comment 

Currency The currency is the unit of measure for the financial values. It is set from a drop 
down list. The available values in the drop down list are configured using the 
Units option from the General menu in the Administration module. The selected 
unit of currency also appears as a suffix in other fields in the dialog: for example 
Price £: 

Price  The retail price of the SKU. 

Cost The purchase cost of the SKU. 

Profit This is the profit attributable to the SKU. Depending on the organization, it may 
be gross profit (sales price less the cost from the supplier), or net profit (profit 
after indirect overheads have been taken into account). 

Calendar 
Period 

The calendar period is the time period the financial data is for. This is set using a 
pre-configured drop down list.  

Sales Definitions may vary, but sales are typically the average value of sales for a 
store within the specified calendar period. 

Unit 
Movement 

This is the number of SKU units that sell during a specific time period. 
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Parameter Comment 

Lead Time The delay between placing an order and receiving it. It can be set to any positive 
integer. 

Unit 
Movement 

The rate at which the item is consumed. This is often for the time period 
specified in the Calendar Period. 

Days of 
Supply  

Definitions may vary, but days of supply is typically total inventory in the 
system divided by average daily consumption. 

Cost Basis Cost Basis can be selected from a drop down list. It is set from a pre-configured 
drop down list. The options are Item or Pack. if set to Pack, the pack quantity 
can be set using the Pack Size spin control on the Physical tab. 

Tax Code Tax code can be selected from a drop down list. The options are configured 
using the Tax Code option accessed from the General menu in the 
Administration Module. 

Custom Tab 
The Custom Tab can be configured to hold customer specific items of information. The 
list of items displayed can be configured using the User Defined Attributes option 
accessed from the General menu in the Administration Module. A maximum of 60 items 
can be configured 

 
This tab enables customer specific information to be assigned to the SKU. In the above 
example, there are five check boxes that allow Yes/No options to be set regarding 
properties of the product, one line for special instructions and three lines for comments. 
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This information can either be set manually or (more probably) brought in via a data 
import. 
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Display Style Information 

Overview of Display Styles 
Display Styles can only be used in the Merchandiser module. They allow products to be 
represented on equipment or shelves with differing degrees of accuracy ranging from a 
simple box to a virtual reality image. 

 
The dialog box consists of the following parts: 

1. A header section that primarily contains information copied from the SKU item that 
is its parent. 

2. A Size and Shape tab that describes the physical form of the Display Style 

3. A Styles tab used to specify the style determining which fixtures and shelves the 
Display Style is compatible with. 

4. An Images tab that allows the user to associate product images with the Display 
Style. 
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5. A Peg Holes tab that allows users to specify how the Display Style will hang from a 
peg (shelf object). 

6. An Orientation Tab that will indicate the positions (upright, on its side, etc), that the 
Display Style can take up when placed on a fixture or shelf object. 

General information at Display style is reflected through from SKU information. 

Parameter Comment 

Name The name of the display style is generally the same as the parent SKU with an 
addition (such as Hanging or Boxed) to show the physical form of the display 
style. 

Description The description of the display style is generally the same as the parent SKU with 
an addition (such as Hanging or Boxed) to show the physical form of the display 
style. 

Client Code The client code (if used) will normally be the same as for the parent SKU. 

UPC The UPC (if used) will normally be the same as for the parent SKU. 

Code The code (if used) will normally be the same as for the parent SKU. 

Manufacturer The manufacturer will normally be the same as for the parent SKU. 

Display Style 
Type 

Display Style Type is set from a drop down list. (This list can be configured from 
the Display Style types on the View menu in Product Studio. 

Unit If the display style type is one which holds multiple instances of a SKU item, the 
quantity should be set to that value. For example a multi pack might contain 6 
items. This information is required for accurate reporting purposes. 

Sellable  The Sellable checkbox indicates whether the display style is for sale or is merely 
there to show the product. An example of a non-sellable display style would be 
when a television is taken out of its boxed and turned on. This is a flag that can be 
set for reporting purposes - for example in a KPI. 

Requires 
Power 

The Requires Power checkbox indicates in the display style requires power. An 
example of this type of display style would be a television that is to be shown 
working. This is a flag that can be set for reporting purposes - for example in a 
KPI. 

 

Note: If the Display Style quantity is set to anything other 
than 1, when the product is placed in Merchandiser, the 
Quantity tab of the Add Products dialog box will show the 
total number of units of merchandise placed. 
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In the above example, 2 x 7 x 3 (=42 ) Display Styles has been placed. As each multi pack 
contains six SKUs, a total of 252 SKUs have been placed on that item of equipment. 

Size and Shape Tab 
The Size and Shape Tab allows the user to specify the Size and Shape of the product. 
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Parameter Comment 

Weight Can be set to any positive numerical value - the units are specified in 
'Weight Units' below. 

Weight Units Units are selected from a drop down menu and can be set to metric or 
imperial units. 

Length Units Units are selected from a drop down menu and can be set to metric or 
imperial units. 

Finger space 
Above 

This spin control sets the finger space above the products. At present this 
information is for information purposes only. 

Finger space 
Beside 

This spin control sets the finger space beside the products. At present this 
information is for information purposes only. 

Shape Shape is selected from a drop down list. It specifies the Product Block used 
for the product, and hence the general type of shape that will be displayed - 
box, cylinder, etc. 

Color This is the color used for simple representations of the product. It can be 
selected from a standard pallet.  

Material This is the coloring form used when products are represented when shown 
as textured boxes. It is selected from a drop down list. (Materials are 
configured via the view pull down menu) 

Jumble Factor The Jumble Factor is a factor that can be used to allow for the lower packing 
density of loose objects. At present this information is for information 
purposes only. 

Size Length, depth can be set to any positive numerical value - the units being 
specified in 'Length Units' above. The size must be set to a positive value or 
the display style will error when being placed in Merchandiser. 

Nesting This specifies the degree to which one unit can be stacked inside each other. 
It is entered as a positive numerical value. 

(For example, 5 vases of height 300 mm and a nesting height of 50 mm 
would have a total height of 500 mm). 

Crush Factor % This specifies how much the dimensions of soft items (such as cushions) 
cam be compressed when stacked. Crush factor does not apply to the top 
item in the stack as it is not being compressed. 
(Three items of 100 mm height with a crush factor of 25% would have a 
combined height of 250 mm: 75 mm + 75 mm + 100 mm). 

Gap This is the gap between multiple instances of a product. It can be set to any 
positive numerical value - the units being specified in 'Length Units' above. 
Half the gap is normally applied to each side of the product. Items stacked 
on top of each other will not normally have a height gap. 

Min 
Stacking/Facings 

This is the minimum number of products that can be placed in the facing, 
depth and height orientations. 

Max 
Stacking/Facings 

This is the maximum number of products that can be placed in the facing, 
depth and height orientations. 
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Styles Tab 
The Styles Tab allows the user to specify the Style(s) associated with the product. These 
in turn determine which fixtures and shelves the product can be placed on. A product 
must have at least one style assigned before it can be placed - and that style must have a 
defined style relationship with the style on the object on which it is being placed. 

 

Parameter Comment 

Available Styles This is the list of styles that can be assigned to the product 

Selected Units This is the list of styles that have been assigned to the product. 

 

Styles are selected or de-selected using the Selection Option buttons. Styles are 
configured in the Administration Module.  

 

Images Tab 
The Images Tab allows the user to specify the Images associated with the product. These 
will display when the product is placed in Macro Space Management Merchandiser if the 
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Draw Products as Graphical option is selected to display the product. Images can be 
imported into Macro Space Management (via Data Importer) or manually selected from 
the Image Capture directory specified in the Configuration Module. 

 
The Directory is the directory that the imported image is held in. The Mapping Format 
specifies whether the images are to be shown using a box or a cross format. 

 
In a Box format, the images are placed on each of the six sides of a cuboid, so the left, 
right, front back, top and bottom images can be seen depending on which direction the 
product is being viewed from. 
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In a Cross format, the images are placed on the sides of a vertically aligned cross. This 
allows users to see images when rotating around it in the horizontal axis, but not when 
viewing it from above or below. Images that can be associated with a product are found 
in the Image Capture directory (specified in the Configuration Module). When assigned, 
they are stored in the Image Root and its associated sub-directories. 

Note: Full details of how to import images are in the section 
on Importing Product Images. 

Peg Holes 
The Peg Holes Tab allows the user to specify the Peg Holes associated with the product. 
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The Peg Hole Toolbar allows users to add a new peg hole to the product, or to delete an 
existing, highlighted one. 

The Peg Hole Settings allow the user to define the position of the peg hole. This may be 
done either using the radio buttons, or by using the spin controls to set the X, Y and Z 
offsets. 

The Defined Pegs Holes show the settings defined for each peg hole. In this example, 
one peg hole has been defined midway across the top of the product. 

The Style Filter is used when multiple styles have been assigned to the product on the 
Styles tab. If the fixture or shelf object also has multiple styles assigned, the style filter 
can be used to pick which style is preferred. 

Orientation Tab 
The Orientation tab is used to specify which positions an item of Merchandise can 
assume when placed on a shelf object. 



Orientation Tab 

Display Style Information 79 

 
An example where this functionality would be used is for a vase. This would be placed 
upright on a shelf, and not on its side. The default orientation is a combination of two 
factors: 

 Which side of the product is facing the front of the fixture or shelf - for example the 
top or back. 

 How that side of the product has been rotated. 

 
In the above example, the default orientation is 'Front', while rotations of 0 degrees, 90 
degrees and 180 degrees are illustrated. 
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Preferred Orientations 
The check boxes in the Preferred Orientations frame can be used to indicate permissible 
orientations.  There are six orientations that the product can be placed: 

 The top of the product could be facing the front of the shelf of fixture. 

 The front of the product could be facing the front of the shelf of fixture. 

 The bottom of the product could be facing the front of the shelf of fixture. 

 The left of the product could be facing the front of the shelf of fixture. 

 The right of the product could be facing the front of the shelf of fixture. 

 The back of the product could be facing the front of the shelf of fixture. 

There are four rotations that can be given to the product. 

 0 degrees  

 90 degrees 

 180 degrees  

 270 degrees  

These combinations of what faces the front of the fixture or shelf and a rotation are not 
unique. For example, 'Front' rotated 90 degrees is the same as 'Left' rotated 0 degrees. 
Preferred orientations can be configured by means of the check boxes. 

Default Orientation 
The default orientation is the orientation the Display Style takes when first placed on a 
fixture or shelf object. 

The default orientation is configured my means of a radio button. 

Note: The orientation functionality can be populated by data 
import or manual selection. The information can then be 
used for reporting purposes. There is currently no restriction 
placed on the orientation when placing a Display Style in the 
Merchandiser module - this functionality is in the process of 
being developed. 

Selecting the orientation when placing the Display Style  

The orientation when placing the Display Style in Merchandiser is selected from the 
Orientation tab of the Add Display Style dialog box. The orientation tab in the Display 
Style dialog box in Product Studio currently places no restrictions on the orientations that 
can be selected. 
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Note: At present this information can only be used for 
reporting purposes - i t has no effect on actual product 
placement. 

Display Style Functionality 
Display Style functionality can only be seen operating in the Merchandiser module and 
in Front and Shelf Graphical view in In-Store Space Collaboration. 

Gap 
If a gap is set for a product, when that product is ungrouped, it will show the products 
separated by the specified gap. 

 
The bottom shelf in the above diagram shows the grouped products. 

Note: while products are grouped, they are scales to show 
the size including the gap. 

The middle shelf shows a similar product but now ungrouped. 
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The top shelf shows a similar product without a gap set. 

Nested Products 
The image below shows an example of nested products. 

 
This option is typically used when objects like bowls or vases are stacked inside each 
other. 
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11 
Other Product Studio Options 

Find Option 
The Find Option can be accessed from the View pull down menu or by <Ctrl + F>. To 
use the Find option, complete the following steps: 

1. In the Find field, enter a value (wild cards such as ? are allowed). 

Note: If no wild card is used, implied wildcards are 
assumed: Find will search for all text containing the text 
string. 

2. Click the Search icon to bring up a list of products matching the search string. 

3. Highlight the required item in the result list, and click on OK to open the pertinent 
node in the Product hierarchy. 

 

Display Style Types 
The Display Style Types option is accessed from the View menu in Product Studio. The 
Add, Edit and Delete icons on the toolbar allow the list to be configured. 

 
 

 



Display Style Types 

84 Oracle Retail Macro Space Management 

Parameter Comment 

Name The name should be a single character. This character must be unique as it acts as 
the identifier (primary key) in the database. 

Description The description is the Display Style Type. 

Code The code is used as look-up when importing data. It is often used when the third-
party database product data is being imported from does not have a display style 
type description, but merely a code. The Code is also used when manually or semi-
automatically importing images to be associated with Display Styles. 

The information then appears in the list of Display Style Types that is set in the Size & 
Shape tab of the display Styles dialog box. 

 
If the Display Style quantity is set to anything other than 1, when the product is placed in 
Merchandiser, the Quantity tab of the Add Products dialog box will show the total 
number of units of merchandise placed. 
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In the above example, 2 x 7 x 3 (= 42) Display Styles has been placed. As each multi pack 
contains six SKUs, a total of 252 SKUs have been placed on that item of equipment. 

Note: When reporting product quantities, the number of 
items in multi  packs, etc, should be taken into account. 

Newly Imported Products 
The Newly Imported Products dialog box allows users to find recently imported 
products. These often require editing if imported from an external database. This is 
because products defined in an external system may lack information required by Macro 
Space Management such as dimensions or images. It can be accessed from the View pull 
down menu and will populate upon being selected with all products that have not been 
modified since the last import date. 

 
The toolbar allows users to close the dialog, edit a selected item, find an item or refresh 
the list with the latest information from the database.   

The Find dialog box is called from the toolbar. 
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It allows users to find items in the list of newly imported products. 

1. In the Find field, enter a value (wild cards such as ? are allowed). 

Note: If no wild card is used, implied wild cards are 
assumed: Find will search for all text containing the text 
string. 

2. Check the required fields in the Search frame. 

3. Set the search direction and other options in the Options frame 

4. Click on Find Next to highlight a product in the list. 

Deleting Products 

Procedure for Deleting Products 
The procedure for deleting products is in two stages. 

1. The product is marked for deletion in Product Studio 

2. The product is purge from the database in the Administration module. 

Only users with access to the Administration module can perform the second stage. 

Marking Products for Deletion 
Products can be marked for deletion by highlighting a node in the product  hierarchy 
then selecting the Delete option from the Edit menu or the right click menu. This will 
delete that node and all child products below it. A confirmatory dialog box will appear. 
Click OK to confirm.  

 

Listing Products Marked for Deletion 
The Deleted Products dialog box (accessed from the Display Deleted Products option 
on the View menu) contains the list of all products marked for deletion. The toolbar 
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allows users to close the dialog box, edit a selected product, find a product, refresh the 
list of deleted products with the latest information from the database or restore a deleted 
product to the product hierarchy. 

 
The Find dialog box can be called from the toolbar. 

  

It allows users to find items in the list of newly imported products. 

1. In the Find field, enter a value (wild cards such as ? are allowed). 

Note: If no wild card is used, implied wild cards are 
assumed: Find will search for all text containing the text 
string. 

2. Check the required fields in the Search frame. 

3. Set the search direction and other options in the Options frame 

4. Click on Find Next to highlight a product in the list. 

Purging Products 
Deleted products can only be permanently removed from the database in the 
Administration Module. Select Purge from the Tools menu.  This will bring up the Purge 
dialog box: 
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Checking the Products option and clicking OK will result in products marked for 
deletion being permanently removed from the Macro Space Planning database. The 
results will be confirmed in a dialog box. 

 

Materials 
The Materials option allows users to configure the Materials using to color equipment. It 
is accessed from the View menu. 

 Material colors can be added, edited or deleted using the toolbar. 

 Transparency can range between 0 (opaque) to 100 (fully transparent). 

 Shininess can range between 0 (matt) to 100 (shiny). 

 Specular values can range between 0 (light only reflects in one direction) to 100 (light 
reflects in all directions). 

 Diffuse values can range between 0 (light is not diffused) to 100 (light is diffused in 
all directions). 



Materials 

Other Product Studio Options 89 

 
 


	Send Us Your Comments
	Preface
	Audience
	Documentation Accessibility
	Related Documents
	Customer Support
	Review Patch Documentation
	Improved Process for Oracle Retail Documentation Corrections
	Oracle Retail Documentation on the Oracle Technology Network
	Conventions

	Overview of Macro Space Planning
	 XE "Overview of Macro Space Planning" \* MERGEFORMAT Overview of Macro Space Planning
	Macro Space Planning
	Relationship with Third-Party Databases
	Product Studio and the Imported Data
	Using Products and their Hierarchy in Macro Space Planning
	Using Products within Planograms

	 XE "Displaying the Product Hierarchy in Planner_ Merchandiser and ISSC" \* MERGEFORMAT Displaying the Product Hierarchy in Planner, Merchandiser and ISSC
	Planner and Merchandiser
	In-Store Space Collaboration


	Logging in to Product Studio
	 XE "Logging into Macro Space Management Modules" \* MERGEFORMAT Logging into Macro Space Management Modules
	Password Changes

	 XE "How Passwords and Privileges are Configured" \* MERGEFORMAT How Passwords and Privileges are Configured
	 XE "Security Server" \* MERGEFORMAT Security Server
	Security Server and Application Errors


	Overview of Product Studio
	 XE "About Product Studio" \* MERGEFORMAT About Product Studio
	File Menu
	Edit Menu
	View Menu
	Window Menu
	Help Menu

	 XE "Overview of Product Hierarchy" \* MERGEFORMAT Overview of Product Hierarchy
	 XE "Placeholders and Display Styles" \* MERGEFORMAT Placeholders and Display Styles
	Placeholders
	Display Styles

	 XE "Deciding on how to Identify the Product" \* MERGEFORMAT Deciding on how to Identify the Product
	 XE "Deciding on the structure of the hierarchy" \* MERGEFORMAT Deciding on the structure of the hierarchy
	General
	Making the Hierarchy User Friendly

	 XE "'Unknown' Levels in Hierarchy" \* MERGEFORMAT 'Unknown' Levels in Hierarchy

	Interactions between Product Studio and Other Modules
	 XE "Product Studio and Other Modules" \* MERGEFORMAT Product Studio and Other Modules
	Administration Module
	Configuration Module
	Data Import
	Planner
	Merchandiser
	In-Store Space Collaboration

	 XE "Administration Module" \* MERGEFORMAT Administration Module
	Category Role
	Manufacturers
	Product Code Types
	Ranges
	Strategies
	Styles
	Tax Codes
	Units
	User Defined Attributes

	 XE "Configuration Module" \* MERGEFORMAT Configuration Module
	Image Capture
	Image Root

	 XE "Data Import" \* MERGEFORMAT Data Import
	 XE "Planner and Merchandiser" \* MERGEFORMAT Planner and Merchandiser
	Planner
	Merchandiser

	 XE "In-Store Space Collaboration" \* MERGEFORMAT In-Store Space Collaboration

	Importing the Product Hierarchy
	 XE "Importing the Product Hierarchy" \* MERGEFORMAT Importing the Product Hierarchy
	Planograms
	Frequency of updates
	Information updated

	 XE "Importing Products with Planogram Import" \* MERGEFORMAT Importing Products with Planogram Import

	Importing Product Images
	 XE "Overview of Importing Product Images" \* MERGEFORMAT Overview of Importing Product Images
	Import Image
	Browse for Image

	 XE "Product Image Configuration" \* MERGEFORMAT Product Image Configuration
	Filename Based On
	Image Sub-Directories

	 XE "Manually Importing Images" \* MERGEFORMAT Manually Importing Images
	 XE "Importing Images" \* MERGEFORMAT Importing Images
	Import for a specific Product
	Full Import


	Using Transparency in Product Images
	 XE "Overview of Transparency and Product Images" \* MERGEFORMAT Overview of Transparency and Product Images
	 XE "Setting the DEFAULT_TRANSPARENCY_COLOUR System Variable" \* MERGEFORMAT Setting the DEFAULT_TRANSPARENCY_COLOUR System Variable
	 XE "Preparing the Image" \* MERGEFORMAT Preparing the Image
	 XE "Adding the Image to a Product" \* MERGEFORMAT Adding the Image to a Product

	Setting up the Basic Hierarchy
	 XE "Setting up Company_ Group_ Division and Department Levels" \* MERGEFORMAT Setting up Company, Group, Division and Department Levels
	 XE "Setting up Class and Sub-Class Levels" \* MERGEFORMAT Setting up Class and Sub-Class Levels
	 XE "Setting up Style_ Item and SKU Levels" \* MERGEFORMAT Setting up Style, Item and SKU Levels
	 XE "Setting up Display Styles" \* MERGEFORMAT Setting up Display Styles

	SKU Level Information
	 XE "Details Tab" \* MERGEFORMAT Details Tab
	 XE "Physical Tab" \* MERGEFORMAT Physical Tab
	 XE "Financial Tab" \* MERGEFORMAT Financial Tab
	 XE "Custom Tab" \* MERGEFORMAT Custom Tab

	Display Style Information
	 XE "Overview of Display Styles" \* MERGEFORMAT Overview of Display Styles
	 XE "Size and Shape Tab" \* MERGEFORMAT Size and Shape Tab
	 XE "Styles Tab" \* MERGEFORMAT Styles Tab
	 XE "Images Tab" \* MERGEFORMAT Images Tab
	 XE "Peg Holes" \* MERGEFORMAT Peg Holes
	 XE "Orientation Tab" \* MERGEFORMAT Orientation Tab
	Preferred Orientations
	Default Orientation

	 XE "Display Style Functionality" \* MERGEFORMAT Display Style Functionality
	Gap
	Nested Products


	Other Product Studio Options
	 XE "Find Option" \* MERGEFORMAT Find Option
	 XE "Display Style Types" \* MERGEFORMAT Display Style Types
	 XE "Newly Imported Products" \* MERGEFORMAT Newly Imported Products
	 XE "Deleting Products" \* MERGEFORMAT Deleting Products
	Procedure for Deleting Products
	Marking Products for Deletion
	Purging Products

	 XE "Materials" \* MERGEFORMAT Materials


